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Allgemeine Informationen:

General information:

Um das Gerét mit einem neuen Programm und/
neuen Methoden, hier firmware genannt, zu
versehen, bendtigen Sie das "Flash-Tool"
HEXLoad und das zu lhrem Geratetyp passend
update in Form einer Datei mit dem "Nachname
.hex (beides erhaltlich auf unserer website
www.tintometer.d¥. Weiterhin ist das mitgelieferte
Datenubertragungskabel erforderlich, um die
Verbindung mit einem PC herzustellen, auf dem
HEXLoad ausgefihrt werden soll (weitere
Erlauterungen: siehe unten).

WICHTIG:

Prufen Sie bitte, ob auf Inrem Computer
Programme laufen, die eventuell die COM-Ports
benutzen oder tberwachen. Dazu zahlen z.B.
Programme zur Uberwachung der Online-Daue
der MSN-Messenger, Chat-Programme und
ahnliche. Diese Programme missen wahrend d
Updates komplett deaktiviert sein, sonst kann e
dazu kommen, das das Flash-Tool "communical
timed out..." meldet und das Update nicht
funktioniert.

WICHTIG:

Bitte drucken oder sichern Sie auf dem Gerat
gespeicherte Ergebnisse vor dem Update!

Bitte drucken oder sichern Sie im Gerat angeleg
Anwender-Methoden (Anwender-Polynome und
Anwender-Konzentrations-Methoden) vor dem
Update. Dies kann mit Hilfe von Mode 67
durchgefuhrt werden.

obemupdate the instruments firmware you need th
flash-tool HEXLoad and the update file *.hex the
fits to your type of instrument (both availableoatr
awebsitewww.tintometer.dg. To connect the PC
munning HEXLoad you need the data
communication cable delivered with the instrum
(more information will follow below).

IMPORTANT:

Please check if programs which monitor the CO
ports are running on your computer. These are {
example programs that log online-time, or the
MSN-Messenger or other chat programs. These
must be completely deactivated during the upda
process, otherwise the flash-tool might report
"communication timed out..." and the update wil
rnot work.

IMPORTANT:

_e|§lease print or save stored results before you

rupdate the instrument!

Sk ase print or save user methods (user-
polynomials and user-concentration-methods)
before updating the instrument. This can done
using Mode 67.
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Installation des Flash-Tools:

Installation of FlasiTool:

Kopieren Sie die Datei HEXLoad.exe in ein leer
Verzeichnis Ihrer Wahl. Das Programm muss ni
installiert werden, ein einfaches Kopieren ist
ausreichend.

cSopy/store the file HEXLoad.exe into an empty
dislder of your choice. The program does not hav
to be installed, just a simple copy/store is enoug

e
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Update der Gerate-Firmware:

Updating the instrumsrfirmware:

Laden Sie die zu Inrem Gerétetyp passende
Firmware-Datei von unserer website herunter ul
kopieren Sie diese *.hex Datei in das gleiche
Verzeichnis wie HEXLoad

Ziehen Sie den Stecker zur Netzversorgung des
Gerates.

Verbinden Sie mit Hilfe des mitgelieferten
Datenubertragungskabels die serielle
Schnittstelle D (siehe Bild unten) mit einem freie

Download the firmware-file fitting to your type of
nothstrument and save this *.hex file in the same
folder as HEXLoad.

Disconnect the mains supply.

Now use the data transmission cable that was
delivered with the instrument to connect the
instruments serial port D (see picture below) vait
free serial port (COMx) of your PC.
n

=

seriellen Anschluss (COMXx) des PCs.
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Schliessen Sie die Netzversorgung wieder an.

Schalten Sie das Gerat bitte aus.

Beim SpectroDirect setzen Sie jetzt den Magnet
(Lieferumfang) auf die daftir vorgesehene
Markierung. Beim PCSpectro Il entféllt dieser
Schritt.

Connect the instrument with mains-adapter.

Please switch off the instrument.

én case of a SpectroDirect put the magnet (part
delivery content) on the marked place. In case @
PCSpectro Il this step is not applicable.

— O

SpectroDirect:
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das Flash-Tool HEXLoad zu starten (siehe Bild).HEXLoad (see picture).

Doppelklicken Sie auf das HEXLoad Symbol, unDouble-Click on the program symbol to start

vy HexLoad ¥2.14i - Untitled

=10l x|
File Edit Yiew Target Options Help
File Target
No data loaded
Area Adr. Len. Gap Data
|Readhy [19200Baud 4

Sie dann auf "Ok". Com-Port Auto. Then click "Ok".

Unter Options> Communication stellen Sie bittg Set the communication parameters with
Baudrate 19200 und Com-Port 'Auto’ ein. KlickerOptions—> Communication to Baudrate 19200 and

Communication parameters il

Baudrate IWEDU ~|

ComPort IAUTO LI Cancel |
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Benutzen Sie den Menu-Punkt Fibe Open... von
HEXLoad, um die Firmware-Datei (*.hex Datei)
laden, welche Sie in einem der Schritte oben vo
unserer website heruntergeladen und in das gle|
Verzeichnis wie HEXLoad gespeichert haben.
Klicken Sie dazu auf die gewlnschte, zu lhrem
Geréatetyp passenden Datei. Diese muss dann i
Feld "Dateiname" erscheinen, siehén
nachfolgender Grafik. Klicken Sie dann auf
"Offnen" (B in der Grafik). Der Dateiname in der
Grafik ist nur ein Beispiel !

Use File=> Open... dialog of HEXLoad to load tl‘Je
dirmware-file (*.hex file) which you download and
rsaved - to the same folder as HEXLoad - at an
ielaglier step. Select the desired firmware version
fitting to your type of instrument, with a click an
The selected file must appear in the field
mMDateiname"” (meaning "filename") séein the
graphic below then click on "Offnen" (meaning
"open”,B in graphic below). The filename at the
graphic is only an example!

Open target program file

2%

Suchen in: | 3 v201.0011.001.003

> e@merEr

SF3 Vel _001_1.C5_
SP3_%201.001.1.001.003 hex

B

\

Diateiname:

ISPE_\J‘EIN .001.1.007.003.hex

dﬁnen |

Dateityp: ITarget program fil

[
=

es (*hex™mot*hin)

Abbrachen |
y

SP3 V201 001 1 001 003.hex ist hier nur ein
Beispiel, bitte benutzen sie die Datei zur
gewilnschten Firmware, passend zum Typ des
Instruments.

SP3 V201 001 1 001_003.hex is an example
only, please use the desired firmware version,
fitting your type of instrument.

Schalten Sie das Gerat jetzt ein. Das Display de
Gerates bleibt dabei dunkel, wenn eine Verbind
zu HEXLoad hergestellt werden kann.

HEXLoad sollte jetzt ahnlich wie folgt aussehen

$Switch the instrument on now. The display of th
Lingtrument stays dark, if it was possible to essabl|
a connection to HexLoad.

11%

HEXLoad should look similar to the example

wobei die Werte nur ein Beispiel darstellen:

below. The values may be different:
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H7EI:I-‘. HexlLoad ¥2.14i - v012_001_3.hex = |EI|£|

File Edit “iew Target Options Help

File Target

Range: 80000 - EFFEF Range(s) 80000 - EFFEF

CRC D1CO CRC 0000

Number of hytes: 146354 Application BTLM16C Dec 11 2002 12:07:48
Number of data areas: 9 CPU M16C

Number of records: 4658 BTL 5/W Version BTL V2.34

Area Adr. Len. Gap Data

0001 00080000 0001D5FB 00000034 FB 7C F2 00 A2 FF FF 75 C0 FF FF 7D F2 7C F2 00
0002 0009D62F 00000004 0000000C 16 36 08 00

0003 0009D63F 00000008 00000010 75 C7 08 00 9F C7 08 00

0004 00090657 000064C4 00000001 6B 07 08 00 20 20 20 20 20 20 20 20 20 20 20 20
0005 000A3B1C00000070 00045474 07 02 23 0D 00 00 00 00 04 04 00 07 02 C6 17 00
0006 000E9000 0000000C 00000014 0C 00 03 00 01 00 03 00 81 A5 01 00

0007 000E9020 00000021 0000005F 32 30 30 33 2D 31 31 2D 30 37 20 31 34 3A 31 35
0008 000E90A0 00000026 00006F06 OD 20 50 6F 6F 6C 43 6F 6E 74 72 6F 6C 44 69 72
0009 000EFFCCO00000024 00 00 08 00 00 00 08 00 00 00 08 00 00 00 08 00

|Readhy [19z00Beud 4

Wichtig ist: It is important that:

» dass unter Fileie Angabe "No data loaded” |« under File the text "No data loaded" was
gewechselt hat und Werte ahnlich wie oben replaced by values, similar as shown above
angezeigt werden

9 9 e under Target values are shown now

* dass unter Targé¥erte erschienen sind If there are not any values displayed under Targ

Erscheinen bei Target keine Werte, so konnte kgime communication with the PC is broken. Please

Verbindung zwischen dem Gerat und dem PC | check the cable and the communication settings.

hergestellt werden. Priifen Sie dann bitte die

Kabelverbindung und die Einstellungen.

Dricken Sie jetzt die F9 Taste auf dem PC. Now press the F9 key on your PC. HEXLoad will

HEXLoad startet den update Vorgang. Dabei |start the update sequence. The following states

werden folgende Zusténde durchlaufen. should be displayed:
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Die alte Firmware wird geldscht:

The old firmwarél\we deleted:

Clearing target

Die neue Firmware wird gespeichert:

The new firmevaill be saved:

Programming target

15%, 22656 of 149230 Indes

Die neue Firmware wird kontrolliert:

The new firmreawill be checked:

Reading checksum of target program

21%%

Die Prifung war erfolgreich und die neue Firmw

wurde gultig gemacht:

afde check was o.k. and the new firmware has |
made valid:

Target has been made walid |

een

Seite 6 von 8

page 6 of 8



Tintometer GmbH
Schleefstr. 8a
44287 Dortmund
Germany

Rev. 0.03

PC Spectro Il

SpectroDirect

Programmupdate

Firmware Update

Klicken Sie auf "ok".
Schliessen Sie jetzt HEXLoad.

Ziehen sie das Datenubertragungskabel vom G
ab.

Bitte warten, bis das Gerat die Methodenliste ze
gegebenenfalls die vom Gerat angezeigten
Bedienschritte ausfuhren (Selbsttest).

Beachten Sie bitte eventuelle Hinweise flr daseg¢
Einschalten nach einem Update, welche bei Bec
mit dem jeweiligen Update bereitgestellt werden

Fuhren Sie bitte jetzt mit MODE 34 ein Loschen
der Daten aus, um das Speichersystem zu
initialisieren.

Fahren Sie anschlieRend mit Mode 69 die
Initialisierung des Anwender-Methoden-
Speicher-Systems durch.

Das Gerat ist jetzt mit der neuen Software
einsatzfahig

Click "ok"
Shut down HEXLoad.

prfisconnect the data transmission cable from the
instrument.

iBtease wait until the instrument displays the
methods list. If applicable, please perform anps
asked for by the instrument (autotest).

2Rlease regard the instructions for first time user:
Japdate that, if necessary, are distributed with th
update.

Please activate MODE 34 and delete all data, tq
initialise the storage-system.

Please activate MODE 69 and initialise the user
method-system.

The instrument is now ready for use with the ne
firmware.

te

S

D

W

Fehlerbehebung:

Troubleshooting:

Problem:

Das Gerat ist korrekt angeschlossen und die
Stromversorgung ist in Ordnung, dennoch
erscheinen nach dem Einschalten des Photome
in HEXLoad unter ,Targétkeine Daten.

Trennen Sie bitte das Photometer vom Computg
und von der Stromversorgung und warten Sie ¢
20 Sekunden. Dann schliessen Sie das Photom
wieder an den PC und an die Stromversorgung
und starten das Update erneut.

Problem:
The photometer is connected the correct way ar
power supply is right, but if you switch on the
tprotometer there is no data at "Tafget
HEXLoad.

Please disconnect the photometer from the
acomputer and from the power supply and wait
etbout 20 seconds. Now connect the photometet
dhe computer and power supply and try again to
update.

nd
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Problem: Problem:

HEXLoad zeigt ,communication timed out"

Bedeutung:
Die Kommunikation von HEXLoad mit dem
Instrument wurde gestort / unterbrochen.

Kontrollieren Sie die Kabelverbindung. Ist all
richtig zusammengesteckt?

Laufen auf lnrem Computer noch
Programme / Prozesse, welche versuchen
konnten mit einer seriellen Schnittstelle
(COMx:) zu kommunizieren (ausser
HEXLoad)? Wenn ja: beenden sie diese bittg

Stellen Sie in HEXLoad unter

Options—> Communication bei ComPort die
von Ihnen fur die Verbindung zum Photomet,
benutzte serielle Schnittstelle fest ein, also z
‘coml:' oder ‘com2:', statt der Einstellung
'‘Auto’.

Versuchen Sie nach jeder Mal3hahme nochmalg
Update durchzufuihren. Dazu trennen Sie bitte
vorher das Photometer vom Computer und von
Stromversorgung und warten ca. 20 Sekunden.
Dann schlie3en Sie das Photometer wieder an ¢
PC und an die Stromversorgung an und starten
Update.

HEXLoad displays ,communication timed out"

Meaning:
The communication between HEXLoad and the
photometer was interrupted or disturbed.

es Check the cable connection of computer anc
photometer

Are there programs running on the computer
which try to use or monitor the serial port
(COMXx:)? Please shut down these programs.

Set the com-port in HEXLoad to a fixed value,
that is ‘com1:' or ‘com2:' or which one you use
on your computer, instead of 'Auto’. This car
done at Options> Communication.

A\1”4

FAfter each of steps above try to update again:
'Please disconnect the photometer from the
computer and wait approximately 20 seconds. N
connect the photometer to the computer and the
sidass supply and start the update.

der

len
das

Problem:

Photometer und Computer sind verbunden,
HEXLoad ist gestartet, aber wenn das Photome|
eingeschaltet wird zeigt dieses das normale
Einschaltverhalten und dann die Methodenliste.

Dieses Verhalten zeigt das Photometer, wenn k
Verbindung zu HEXLoad hergestellt werden kar

Ist das Kabel zum Computer richtig
angeschlossen?

Ist das Kabel am Computer an der seriellen
Schnittstelle angeschlossen, die in HEXLoag

Problem:
Photometer and computer are connected, HEXL
tex running, but if you switch on the photometer it
shows the normal start-up behaviour and after t
the methods list

hat

eline photometer shows this behaviour, if it cannot

detect a connection to HEXLoad.

Is the cable to the computer connected the r
way?

ght

Is the cable connected to the serial port at the

1 computer that is set in HEXLoad

eingestellt ist (Option® Communication)?

(Options—> Communication)?
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